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COMPLETE SYSTEMS
LIQUID PHASE

PART
DESCRIPTION NUMBER

PRS-14-9-2-C 4101
PRS-14-9-2-S 4102
PRS-14-6-3-C 4103
PRS-14-6-3-S 4104

VAPOR PHASE
PART

DESCRIPTION NUMBER

PRS-14-7-2-C 4105
PRS-14-7-2-S 4106
PRS-14-6-2-C 4107
PRS-14-6-2-S 4108
PRS-14-4-3-C 4109
PRS-14-4-3-S 4110

ACCESSORIES
INDIVIDUAL BOXES

PART
DESCRIPTION NUMBER

Cardboard – 2” 4B2C
Cardboard – 3” 4B3C
Aluminum – 2” 4B2A
Aluminum – 3” 4B3A
Stainless Steel – 2” 4B2S
Stainless Steel – 3” 4B3S

INDIVIDUAL DIVIDERS
PART

DESCRIPTION NUMBER

¹/₂” Divider (56 Cell) 12.70 mm opening 4D12
⁵/₈” Divider (42 Cell) 15.87 mm opening 4D58

EXTRAS
PART

DESCRIPTION NUMBER

Platform Riser 4PR
Locking Rods 4LR

INDIVIDUAL RACKS
COMPLETE

PART
DESCRIPTION NUMBER

PRC-14-9-2-C 4201
PRC-14-9-2-S 4202
PRC-14-7-2-C 4203
PRC-14-7-2-S 4204
PRC-14-6-2-C 4205
PRC-14-6-2-S 4206
PRC-14-6-3-C 4207
PRC-14-6-3-S 4208
PRC-14-4-3-C 4209
PRC-14-4-3-S 4210

RACKS ONLY
PART

DESCRIPTION NUMBER

PRO-14-9-2 4301
PRO-14-7-2 4302
PRO-14-6-2 4303
PRO-14-6-3 4304
PRO-14-4-3 4305

-EXAMPLE OF DESCRIPTION-

PRS - 14 - 9 - 2 - C - ¹/₂
Cell Divider
Opening ¹/₂” or ⁵/₈”Type of Box: C - Cardboard

S - Stainless Steel   A - Aluminum
Number of
Boxes per Rack

Height
of Box

Inside Diameter of Unit into
which Racks are fitted

PRS – Pie Rack System
PRC – Pie Rack Complete
PRO – Pie Rack Only

14” LIQUID NITROGEN FREEZER RACKS
COMPLETE SYSTEMS AND INDIVIDUAL RACKS FOR 

14 INCH DIAMETER CONTAINERS
Complete system consists of (6) “pie-shaped” racks constructed entirely from stainless steel. All systems include choice of durable

cardboard, lightweight aluminum, or stainless steel boxes along with choice of 1/2” or 5/8” cell dividers. All systems are available for
either liquid phase or vapor phase storage. All racks include locking rods. Custom racks available upon request.

NOTES:  1. All vapor phase systems include vapor platforms.       2. Specify divider size when ordering racks.

6  / "1
2

60 o

DISCONTINUED

Ted Lang



2

COMPLETE SYSTEMS
LIQUID PHASE

PART
DESCRIPTION NUMBER

PRS-16-12-2-C 6101
PRS-16-12-2-S 6102
PRS-16-9-2-C 6107
PRS-16-9-2-S 6108
PRS-16-8-3-C 6109
PRS-16-8-3-S 6110
PRS-16-6-3-C 6111
PRS-16-6-3-S 6112
PRS-16-6-3.75-C 6113
PRS-16-6-3.75-S 6114
PRS-16-5-3.75-C 6115
PRS-16-5-3.75-S 6116

VAPOR PHASE
PART

DESCRIPTION NUMBER

PRS-16-9-2-C 6119
PRS-16-9-2-S 6120
PRS-16-6-2-C 6121
PRS-16-6-2-S 6122
PRS-16-6-3-C 6125
PRS-16-6-3-S 6126
PRS-16-4-3-C 6127
PRS-16-4-3-S 6128
PRS-16-5-3.75-C 6131
PRS-16-5-3.75-S 6132
PRS-16-4-3.75-C 6133
PRS-16-4-3.75-S 6134

INDIVIDUAL RACKS
COMPLETE

PART
DESCRIPTION NUMBER

PRC-16-12-2-C 6201
PRC-16-12-2-S 6202
PRC-16-9-2-C 6207
PRC-16-9-2-S 6208
PRC-16-6-2-C 6209
PRC-16-6-2-S 6210
PRC-16-8-3-C 6211
PRC-16-8-3-S 6212
PRC-16-6-3-C 6215
PRC-16-6-3-S 6216
PRC-16-4-3-C 6217
PRC-16-4-3-S 6218
PRC-16-6-3.75-C 6219
PRC-16-6-3.75-S 6220
PRC-16-5-3.75-C 6221
PRC-16-5-3.75-S 6222
PRC-16-4-3.75-C 6223
PRC-16-4-3.75-S 6224

RACKS ONLY
PART

DESCRIPTION NUMBER

PRO-16-12-2 6301
PRO-16-9-2 6304
PRO-16-6-2 6305
PRO-16-8-3 6306
PRO-16-6-3 6308
PRO-16-4-3 6309
PRO-16-6-3.75 6310
PRO-16-5-3.75 6311
PRO-16-4-3.75 6312

-EXAMPLE OF DESCRIPTION-

PRS - 16 - 9 - 2 - C - ¹/₂
Cell Divider
Opening ¹/₂” or ⁵/₈”Type of Box: C - Cardboard

S - Stainless Steel   A - Aluminum
Number of
Boxes per Rack

Height
of Box

Inside Diameter of Unit into
which Racks are fitted

PRS – Pie Rack System
PRC – Pie Rack Complete
PRO – Pie Rack Only

16” LIQUID NITROGEN FREEZER RACKS
COMPLETE SYSTEMS AND INDIVIDUAL RACKS FOR 

16 INCH DIAMETER CONTAINERS
Complete system consists of (6) “pie-shaped” racks constructed entirely from stainless steel. All systems include choice of durable

cardboard, lightweight aluminum, or stainless steel boxes along with choice of 1/2” or 5/8” cell dividers. All systems are available for
either liquid phase or vapor phase storage. All racks include locking rods. Custom racks available upon request.

NOTES:  1. All vapor phase systems include vapor platforms.       2. Specify divider size when ordering racks.

ACCESSORIES
INDIVIDUAL BOXES

PART
DESCRIPTION NUMBER

Cardboard – 2” 6B2C
Cardboard – 3” 6B3C
Aluminum – 2” 6B2A
Aluminum – 3” 6B3A
Stainless Steel – 2” 6B2S
Stainless Steel – 3” 6B3S

INDIVIDUAL DIVIDERS
PART

DESCRIPTION NUMBER

¹/₂” Divider (81 Cell) 12.70 mm opening 6D12
⁵/₈” Divider (53 Cell) 15.87 mm opening 6D58

EXTRAS
PART

DESCRIPTION NUMBER

Platform Riser 6PR
Locking Rods 6LR
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COMPLETE SYSTEMS
LIQUID PHASE

PART
DESCRIPTION NUMBER

PRS-18-12-2-C 8101
PRS-18-12-2-S 8102
PRS-18-11-2-C 8103
PRS-18-11-2-S 8104
PRS-18-8-3-C 8105
PRS-18-8-3-S 8106
PRS-18-6-3.75-C 8107
PRS-18-6-3.75-S 8108

VAPOR PHASE
PART

DESCRIPTION NUMBER

PRS-18-10-2-C 8109
PRS-18-10-2-S 8110
PRS-18-9-2-C 8111
PRS-18-9-2-S 8112
PRS-18-7-3-C 8113
PRS-18-7-3-S 8114
PRS-18-6-3-C 8115
PRS-18-6-3-S 8116
PRS-18-5-3.75-C 8117
PRS-18-5-3.75-S 8118

INDIVIDUAL RACKS
COMPLETE

PART
DESCRIPTION NUMBER

PRC-18-12-2-C 8201
PRC-18-12-2-S 8202
PRC-18-11-2-C 8203
PRC-18-11-2-S 8204
PRC-18-10-2-C 8205
PRC-18-10-2-S 8206
PRC-18-9-2-C 8207
PRC-18-9-2-S 8208
PRC-18-8-3-C 8209
PRC-18-8-3-S 8210
PRC-18-7-3-C 8211
PRC-18-7-3-S 8212
PRC-18-6-3-C 8213
PRC-18-6-3-S 8214
PRC-18-6-3.75-C 8215
PRC-18-6-3.75-S 8216
PRC-18-5-3.75-C 8217
PRC-18-5-3.75-S 8218

RACKS ONLY
PART

DESCRIPTION NUMBER

PRO-18-12-2 8301
PRO-18-11-2 8302
PRO-18-10-2 8303
PRO-18-9-2 8304
PRO-18-8-3 8305
PRO-18-7-3 8306
PRO-18-6-3 8307
PRO-18-6-3.75 8308
PRO-18-5-3.75 8309

-EXAMPLE OF DESCRIPTION-

PRS - 18 - 12 - 2 - C - ¹/₂
Cell Divider
Opening ¹/₂” or ⁵/₈”Type of Box: C - Cardboard

S - Stainless Steel   A - Aluminum
Number of
Boxes per Rack

Height
of Box

Inside Diameter of Unit into
which Racks are fitted

PRS – Pie Rack System
PRC – Pie Rack Complete
PRO – Pie Rack Only

18” LIQUID NITROGEN FREEZER RACKS
COMPLETE SYSTEMS AND INDIVIDUAL RACKS FOR 

18 INCH DIAMETER CONTAINERS
Complete system consists of (6) “pie-shaped” racks constructed entirely from stainless steel. All systems include choice of durable

cardboard, lightweight aluminum, or stainless steel boxes along with choice of 1/2” or 5/8” cell dividers. All systems are available for
either liquid phase or vapor phase storage. All racks include locking rods. Custom racks available upon request.

3

NOTES:  1. All vapor phase systems include vapor platforms.       2. Specify divider size when ordering racks.

ACCESSORIES
INDIVIDUAL BOXES

PART
DESCRIPTION NUMBER

Cardboard – 2” 8B2C
Cardboard – 3” 8B3C
Aluminum – 2” 8B2A
Aluminum – 3” 8B3A
Stainless Steel – 2” 8B2S
Stainless Steel – 3” 8B3S

INDIVIDUAL DIVIDERS
PART

DESCRIPTION NUMBER

¹/₂” Divider (112 Cell) 12.70 mm opening 8D12
⁵/₈” Divider 15.87 mm opening 8D58

EXTRAS
PART

DESCRIPTION NUMBER

Platform Riser 8PR
Locking Rods 8LR
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COMPLETE SYSTEMS
LIQUID PHASE

PART
DESCRIPTION NUMBER

PRS-19-11-2-C 9101
PRS-19-11-2-S 9102
PRS-19-7-3-C 9103
PRS-19-7-3-S 9104

VAPOR PHASE
PART

DESCRIPTION NUMBER

PRS-19-9-2-C 9107
PRS-19-9-2-S 9108
PRS-19-6-3-C 9109
PRS-19-6-3-S 9110

ACCESSORIES
INDIVIDUAL BOXES

PART
DESCRIPTION NUMBER

Cardboard – 2” 9B2C
Cardboard – 3” 9B3C
Aluminum – 2” 9B2A
Aluminum – 3” 9B3A
Stainless Steel – 2” 9B2S
Stainless Steel – 3” 9B3S

INDIVIDUAL DIVIDERS
PART

DESCRIPTION NUMBER

¹/₂” Divider (86 Cell) 12.70 mm opening 9D12C
(Cardboard box only)

⁵/₈” Divider (64 Cell) 15.87 mm opening 9D58C
(Cardboard box only)

¹/₂” Divider (104 Cell) 12.70 mm opening 9D12S
(Stainless steel box only)

⁵/₈” Divider (80 Cell) 15.87 mm opening 9D58S
(Stainless steel box only)

EXTRAS
PART

DESCRIPTION NUMBER

Platform Riser 9PR
Locking Rods 9LR

INDIVIDUAL RACKS
COMPLETE

PART
DESCRIPTION NUMBER

PRC-19-11-2-C 9201
PRC-19-11-2-S 9202
PRC-19-9-2-C 9205
PRC-19-9-2-S 9206
PRC-19-7-3-C 9207
PRC-19-7-3-S 9208
PRC-19-6-3-C 9209
PRC-19-6-3-S 9210

RACKS ONLY
PART

DESCRIPTION NUMBER

PRO-19-11-2 9301
PRO-19-9-2 9303
PRO-19-7-3 9304
PRO-19-6-3 9305

-EXAMPLE OF DESCRIPTION-

PRS - 19 - 11 - 2 - C - ¹/₂
Cell Divider
Opening ¹/₂” or ⁵/₈”Type of Box: C - Cardboard

S - Stainless Steel   A - Aluminum
Number of
Boxes per Rack

Height
of Box

Inside Diameter of Unit into
which Racks are fitted

PRS – Pie Rack System
PRC – Pie Rack Complete
PRO – Pie Rack Only

19” LIQUID NITROGEN FREEZER RACKS
COMPLETE SYSTEMS AND INDIVIDUAL RACKS FOR 

19 INCH DIAMETER CONTAINERS
Complete system consists of (7) “pie-shaped” racks constructed entirely from stainless steel. All systems include choice of durable

cardboard, lightweight aluminum, or stainless steel boxes along with choice of 1/2” or 5/8” cell dividers. All systems are available for
either liquid phase or vapor phase storage. All racks include locking rods. Custom racks available upon request.

NOTES:  1. All vapor phase systems include vapor platforms.       2. Specify divider size when ordering racks.
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LIQUID PHASE SYSTEMS
DESCRIPTION PART NUMBER SYSTEM HEIGHT

SRS-20-13-2-C 2001 27¹⁄₂”
SRS-20-13-2-S 2002 27¹⁄₂”
SRS-20-12-2-C 2003 25¹⁄₂”
SRS-20-12-2-S 2004 25¹⁄₂”
SRS-20-11-2-C 2005 23⁷⁄₁₆”
SRS-20-11-2-S 2006 23⁷⁄₁₆”
SRS-20-9-3-C 2007 28¹⁄₈”
SRS-20-9-3-S 2008 28¹⁄₈”
SRS-20-8-3-C 2009 25”
SRS-20-8-3-S 2010 25”
SRS-20-7-3.75-C 2011 26³⁄₄”
SRS-20-7-3.75-S 2012 26³⁄₄”
SRS-20-6-3.75-C 2013 23”
SRS-20-6-3.75-S 2014 23”

VAPOR PHASE SYSTEMS
DESCRIPTION PART NUMBER SYSTEM HEIGHT

SRS-20-10-2-C 2015 25¹⁄₂”
SRS-20-10-2-S 2016 25¹⁄₂”
SRS-20-9-2-C 2017 25¹⁄₄”
SRS-20-9-2-S 2018 25¹⁄₄”
SRS-20-7-3-C 2019 26”
SRS-20-7-3-S 2020 26”
SRS-20-6-3-C 2021 25”
SRS-20-6-3-S 2022 25”
SRS-20-5-3.75-C 2023 25¹⁄₄”
SRS-20-5-3.75-S 2024 25¹⁄₄”

-EXAMPLE OF DESCRIPTION-

SRS - 20 - 12 - 2 - C - 81
Number of Cell Openings: 
100, 81, 64, 49, 36, 25, etc.Type of Box: 

C - Cardboard  S - Stainless Steel   
A - Aluminum  P - Plastic (soon available)

Number of
Boxes per Rack

Height
of Box

Inside Diameter of Unit into
which Racks are fitted

SRS – Square Rack System

20” LIQUID NITROGEN FREEZER RACKS
COMPLETE RACK SYSTEMS FOR 20 INCH DIAMETER CONTAINERS

Complete system consists of (7) square racks constructed entirely from stainless steel. All systems include choice of 
durable cardboard, lightweight aluminum, stainless steel or plastic boxes (soon available). Each system also includes choice 

of cell dividers; 100, 81, 64, 49, 36, 25. All systems are available for either liquid phase or vapor phase storage. 
All racks include locking rods.  Custom racks available upon request.
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NOTES:  1. All vapor phase systems include vapor platforms.       2. Specify divider size when ordering racks.
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LIQUID PHASE SYSTEMS
DESCRIPTION PART NUMBER SYSTEM HEIGHT

SRS-31-13-2-C 3101 27¹⁄₂”
SRS-31-13-2-S 3102 27¹⁄₂”
SRS-31-12-2-C 3103 25¹⁄₂”
SRS-31-12-2-S 3104 25¹⁄₂”
SRS-31-11-2-C 3105 23⁷⁄₁₆”
SRS-31-11-2-S 3106 23⁷⁄₁₆”
SRS-31-9-3-C 3107 28¹⁄₈”
SRS-31-9-3-S 3108 28¹⁄₈”
SRS-31-8-3-C 3109 25”
SRS-31-8-3-S 3110 25”
SRS-31-7-3.75-C 3111 26³⁄₄”
SRS-31-7-3.75-S 3112 26³⁄₄”
SRS-31-6-3.75-C 3113 23”
SRS-31-6-3.75-S 3114 23”

VAPOR PHASE SYSTEMS
DESCRIPTION PART NUMBER SYSTEM HEIGHT

SRS-31-10-2-C 3115 25¹⁄₂”
SRS-31-10-2-S 3116 25¹⁄₂”
SRS-31-9-2-C 3117 25¹⁄₄”
SRS-31-9-2-S 3118 25¹⁄₄”
SRS-31-7-3-C 3119 26”
SRS-31-7-3-S 3120 26”
SRS-31-6-3-C 3121 25”
SRS-31-6-3-S 3122 25”
SRS-31-5-3.75-C 3123 25¹⁄₄”
SRS-31-5-3.75-S 3124 25¹⁄₄”

-EXAMPLE OF DESCRIPTION-

SRS - 31 - 12 - 2 - C - 81
Number of Cell Openings: 
100, 81, 64, 49, 36, 25, etc.Type of Box: 

C - Cardboard  S - Stainless Steel   
A - Aluminum  P - Plastic (soon available)

Number of
Boxes per Rack

Height
of Box

Inside Diameter of Unit into
which Racks are fitted

SRS – Square Rack System

31” LIQUID NITROGEN FREEZER RACKS
COMPLETE RACK SYSTEMS FOR 31 INCH DIAMETER CONTAINERS

Complete system consists of (17) square racks constructed entirely from stainless steel. All systems include choice of 
durable cardboard, lightweight aluminum, stainless steel or plastic boxes (soon available). Each system also includes choice 

of cell dividers; 100, 81, 64, 49, 36, 25. All systems are available for either liquid phase or vapor phase storage. 
All racks include locking rods.  Custom racks available upon request.

NOTES:  1. All vapor phase systems include vapor platforms.       2. Specify divider size when ordering racks.



LIQUID PHASE SYSTEMS
DESCRIPTION PART NUMBER SYSTEM HEIGHT

SRS-39-13-2-C 3301 27¹⁄₂”
SRS-39-13-2-S 3302 27¹⁄₂”
SRS-39-12-2-C 3303 25¹⁄₂”
SRS-39-12-2-S 3304 25¹⁄₂”
SRS-39-11-2-C 3305 23⁷⁄₁₆”
SRS-39-11-2-S 3306 23⁷⁄₁₆”
SRS-39-9-3-C 3307 28¹⁄₈”
SRS-39-9-3-S 3308 28¹⁄₈”
SRS-39-8-3-C 3309 25”
SRS-39-8-3-S 3310 25”
SRS-39-7-3.75-C 3311 26³⁄₄”
SRS-39-7-3.75-S 3312 26³⁄₄”
SRS-39-6-3.75-C 3313 23”
SRS-39-6-3.75-S 3314 23”

VAPOR PHASE SYSTEMS
DESCRIPTION PART NUMBER SYSTEM HEIGHT

SRS-39-10-2-C 3315 25¹⁄₂”
SRS-39-10-2-S 3316 25¹⁄₂”
SRS-39-9-2-C 3317 25¹⁄₄”
SRS-39-9-2-S 3318 25¹⁄₄”
SRS-39-7-3-C 3319 26”
SRS-39-7-3-S 3320 26”
SRS-39-6-3-C 3321 25”
SRS-39-6-3-S 3322 25”
SRS-39-5-3.75-C 3323 25¹⁄₄”
SRS-39-5-3.75-S 3324 25¹⁄₄”

-EXAMPLE OF DESCRIPTION-

SRS - 39 - 12 - 2 - C - 81
Number of Cell Openings: 
100, 81, 64, 49, 36, 25, etc.Type of Box: 

C - Cardboard  S - Stainless Steel   
A - Aluminum  P - Plastic (soon available)

Number of
Boxes per Rack

Height
of Box

Inside Diameter of Unit into
which Racks are fitted

SRS – Square Rack System

39” LIQUID NITROGEN FREEZER RACKS
COMPLETE RACK SYSTEMS FOR 39 INCH DIAMETER CONTAINERS

Complete system consists of (28) square racks constructed entirely from stainless steel. All systems include choice of 
durable cardboard, lightweight aluminum, stainless steel or plastic boxes (soon available). Each system also includes choice 

of cell dividers; 100, 81, 64, 49, 36, 25. All systems are available for either liquid phase or vapor phase storage. 
All racks include locking rods.  Custom racks available upon request.
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NOTES:  1. All vapor phase systems include vapor platforms.       2. Specify divider size when ordering racks.



STANDARD RACKS
COMPLETE

PART RACK HEIGHT
DESCRIPTION NUMBER CAPACITY STANDARD OPTIONAL

SRC-13-2-C 1101 (13) Boxes 27¹⁄₂” 28¹⁄₂”
SRC-13-2-S 1102 (13) Boxes 27¹⁄₂” 28¹⁄₂”
SRC-12-2-C 1103 (12) Boxes 25¹⁄₂” 26⁹⁄₁₆”
SRC-12-2-S 1104 (12) Boxes 25¹⁄₂” 26⁹⁄₁₆”
SRC-11-2-C 1105 (11) Boxes 23⁷⁄₁₆” 24¹⁄₂”
SRC-11-2-S 1106 (11) Boxes 23⁷⁄₁₆” 24¹⁄₂”
SRC-10-2-C 1107 (10) Boxes 21³⁄₈” 22¹⁄₄”
SRC-10-2-S 1108 (10) Boxes 21³⁄₈” 22¹⁄₄”
SRC-9-2-C 1109 (9) Boxes 19¹⁄₄” 20”
SRC-9-2-S 1110 (9) Boxes 19¹⁄₄” 20”
SRC-8-2-C 1111 (8) Boxes 17¹⁄₈” 17³⁄₄”
SRC-8-2-S 1112 (8) Boxes 17¹⁄₈” 17³⁄₄”
SRC-7-2-C 1113 (7) Boxes 15” 15⁵⁄₈”
SRC-7-2-S 1114 (7) Boxes 15” 15⁵⁄₈”
SRC-6-2-C 1115 (6) Boxes 12¹⁵⁄₁₆” 13⁷⁄₁₆”
SRC-6-2-S 1116 (6) Boxes 12¹⁵⁄₁₆” 13⁷⁄₁₆”
SRC-5-2-C 1117 (5) Boxes 10³⁄₄” 11⁵⁄₁₆”
SRC-5-2-S 1118 (5) Boxes 10³⁄₄” 11⁵⁄₁₆”
SRC-4-2-C 1119 (4) Boxes 8¹¹⁄₁₆” 9¹⁄₈”
SRC-4-2-S 1120 (4) Boxes 8¹¹⁄₁₆” 9¹⁄₈”
SRC-3-2-C 1121 (3) Boxes 6⁵⁄₈” 7”
SRC-3-2-S 1122 (3) Boxes 6⁵⁄₈” 7”
SRC-9-3-C 1123 (9) Boxes 28¹⁄₈” 28⁷⁄₈”
SRC-9-3-S 1124 (9) Boxes 28¹⁄₈” 28⁷⁄₈”
SRC-8-3-C 1125 (8) Boxes 25” 25⁷⁄₈”
SRC-8-3-S 1126 (8) Boxes 25” 25⁷⁄₈”
SRC-7-3-C 1127 (7) Boxes 21¹⁵⁄₁₆” 22³⁄₄”
SRC-7-3-S 1128 (7) Boxes 21¹⁵⁄₁₆” 22³⁄₄”
SRC-6-3-C 1129 (6) Boxes 18⁷⁄₈” 19¹⁄₂”
SRC-6-3-S 1130 (6) Boxes 18⁷⁄₈” 19¹⁄₂”
SRC-5-3-C 1131 (5) Boxes 15³⁄₄” 16³⁄₈”
SRC-5-3-S 1132 (5) Boxes 15³⁄₄” 16³⁄₈”
SRC-4-3-C 1133 (4) Boxes 12⁵⁄₈” 13¹⁄₄”
SRC-4-3-S 1134 (4) Boxes 12⁵⁄₈” 13¹⁄₄”
SRC-7-3.75-C 1135 (7) Boxes 26³⁄₄” 26³⁄₄”
SRC-7-3.75-S 1136 (7) Boxes 26³⁄₄” 26³⁄₄”
SRC-6-3.75-C 1137 (6) Boxes 23” 23”
SRC-6-3.75-S 1138 (6) Boxes 23” 23”
SRC-5-3.75-C 1139 (5) Boxes 19¹⁄₈” 19¹⁄₈”
SRC-5-3.75-S 1140 (5) Boxes 19¹⁄₈” 19¹⁄₈”
SRC-4-3.75-C 1141 (4) Boxes 15³⁄₈” 15³⁄₈”
SRC-4-3.75-S 1142 (4) Boxes 15³⁄₈” 15³⁄₈”

STANDARD RACKS ONLY
PART RACK HEIGHT

DESCRIPTION NUMBER CAPACITY STANDARD OPTIONAL
SRO-13-2 1201 (13) Boxes 27¹⁄₂” 28¹⁄₂”
SRO-12-2 1202 (12) Boxes 25¹⁄₂” 26⁹⁄₁₆”
SRO-11-2 1203 (11) Boxes 23⁷⁄₁₆” 24¹⁄₂”
SRO-10-2 1204 (10) Boxes 21³⁄₈” 22¹⁄₄”
SRO-9-2 1205 (9) Boxes 19¹⁄₄” 20”
SRO-8-2 1206 (8) Boxes 17¹⁄₈” 17³⁄₄”
SRO-7-2 1207 (7) Boxes 15” 15⁵⁄₈”
SRO-6-2 1208 (6) Boxes 12¹⁵⁄₁₆” 13⁷⁄₁₆”
SRO-5-2 1209 (5) Boxes 10³⁄₄” 11⁵⁄₁₆”
SRO-4-2 1210 (4) Boxes 8¹¹⁄₁₆” 9¹⁄₈”
SRO-3-2 1211 (3) Boxes 6⁵⁄₈” 7”
SRO-9-3 1212 (9) Boxes 28¹⁄₈” 28⁷⁄₈”
SRO-8-3 1213 (8) Boxes 25” 25⁷⁄₈”
SRO-7-3 1214 (7) Boxes 21¹⁵⁄₁₆” 22³⁄₄”
SRO-6-3 1215 (6) Boxes 18⁷⁄₈” 19¹⁄₂”
SRO-5-3 1216 (5) Boxes 15³⁄₄” 16³⁄₈”
SRO-4-3 1217 (4) Boxes 12⁵⁄₈” 13¹⁄₄”
SRO-7-3.75 1218 (7) Boxes 26³⁄₄” 26³⁄₄”
SRO-6-3.75 1219 (6) Boxes 23” 23”
SRO-5-3.75 1220 (5) Boxes 19¹⁄₈” 19¹⁄₈”
SRO-4-3.75 1221 (4) Boxes 15³⁄₈” 15³⁄₈”

MINI RACKS ONLY
PART RACK HEIGHT

DESCRIPTION NUMBER CAPACITY STANDARD OPTIONAL
MRO-13-2 M101 (13) Boxes 27¹⁄₂” 28¹⁄₂”
MRO-12-2 M102 (12) Boxes 25¹⁄₂” 26⁹⁄₁₆”
MRO-11-2 M103 (11) Boxes 23⁷⁄₁₆” 24¹⁄₂”
MRO-10-2 M104 (10) Boxes 21³⁄₈” 22¹⁄₄”
MRO-9-2 M105 (9) Boxes 19¹⁄₄” 20”
MRO-8-2 M106 (8) Boxes 17¹⁄₈” 17³⁄₄”
MRO-7-2 M107 (7) Boxes 15” 15⁵⁄₈”
MRO-6-2 M108 (6) Boxes 12¹⁵⁄₁₆” 13⁷⁄₁₆”
MRO-5-2 M109 (5) Boxes 10³⁄₄” 11⁵⁄₁₆”
MRO-4-2 M110 (4) Boxes 8¹¹⁄₁₆” 9¹⁄₈”
MRO-3-2 M111 (3) Boxes 6⁵⁄₈” 7”
MRO-9-3 M112 (9) Boxes 28¹⁄₈” 28⁷⁄₈”
MRO-8-3 M113 (8) Boxes 25” 25⁷⁄₈”
MRO-7-3 M114 (7) Boxes 21¹⁵⁄₁₆” 22³⁄₄”
MRO-6-3 M115 (6) Boxes 18⁷⁄₈” 19¹⁄₂”
MRO-5-3 M116 (5) Boxes 15³⁄₄” 16³⁄₈”
MRO-4-3 M117 (4) Boxes 12⁵⁄₈” 13¹⁄₄”
MRO-7-3.75 M118 (7) Boxes 26³⁄₄” 26³⁄₄”
MRO-6-3.75 M119 (6) Boxes 23” 23”
MRO-5-3.75 M120 (5) Boxes 19¹⁄₈” 19¹⁄₈”
MRO-4-3.75 M121 (4) Boxes 15³⁄₈” 15³⁄₈”

-EXAMPLE OF DESCRIPTION-

SRC - 12 - 2 - C - 81 Number of 
Cell Openings: 
100, 81, 64, 
49, 25, 16Type of Box: C - Cardboard  

S - Stainless Steel   A - Aluminum
Number of
Boxes per Rack

Height
of Box

SRC – Square Rack
Complete

SRO – Square Rack 
Only

MRO –Mini Rack 
Only

LIQUID NITROGEN FREEZER RACKS
INDIVIDUAL SQUARE RACKS

Individual Square Racks are constructed entirely from stainless steel. All racks are available
complete with boxes and cell dividers or purchased separately. All square racks have a standard
51/2”x 51/2” (front to back), (side to side) dimension. All racks include locking rods. Custom
racks available upon request.

8

NOTES:  1. Specify divider size when ordering racks.      2. Rack height (optional), accepts plastic boxes also.

SRO-8-3
SRO-12-2

SRO-5-3.75
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NOTE:  Metal boxes available with lift off or hinged tops. Consult factory for prices.

STANDARD BOXES AND CELL DIVIDERS
For All Upright Freezer And Chest Freezer Racks.

Constructed of recycled paper products, aluminum or stainless steel. Custom sizes available upon request.

STANDARD BOXES

CARDBOARD
PART DIMENSIONS

DESCRIPTION NUMBER (OUTSIDE)

Regular - 2” B2C 5¹⁄₄” x 5¹⁄₄” x 1⁷⁄₈”
Regular - 3” B3C 5¹⁄₄” x 5¹⁄₄” x 2⁷⁄₈”

STANDARD CELL
DIVIDERS

PART CELL OPENING DIMENSIONS
NUMBER MM IN (OUTSIDE)

D16 30.23    1.19 4⁷⁄₈” x 4⁷⁄₈”

STAINLESS STEEL
PART DIMENSIONS

DESCRIPTION NUMBER (OUTSIDE)

Regular - 2” B2S 5” x 5” x 1⁷⁄₈”
Regular - 3” B3S 5” x 5” x 2⁷⁄₈”

ALUMINUM
PART DIMENSIONS

DESCRIPTION NUMBER (OUTSIDE)

Regular - 2” B2A 5” x 5” x 1⁷⁄₈”
Regular - 3” B3A 5” x 5” x 2⁷⁄₈”

16
CELL

PART CELL OPENING DIMENSIONS
NUMBER MM IN (OUTSIDE)

D25 24.51    0.96 4⁷⁄₈” x 4⁷⁄₈”

25
CELL

PART CELL OPENING DIMENSIONS
NUMBER MM IN (OUTSIDE)

D49 16.76    0.66 4⁷⁄₈” x 4⁷⁄₈”

49
CELL

PART CELL OPENING DIMENSIONS
NUMBER MM IN (OUTSIDE)

D64 14.60     0.57 4⁷⁄₈” x 4⁷⁄₈”

64
CELL

PART CELL OPENING DIMENSIONS
NUMBER MM IN (OUTSIDE)

D81 12.70     0.50 4⁷⁄₈” x 4⁷⁄₈”

81
CELL

PART CELL OPENING DIMENSIONS
NUMBER MM IN (OUTSIDE)

D100 11.65     0.45 4⁷⁄₈” x 4⁷⁄₈”

100
CELL



10

NOTE:  Metal boxes available with lift off or hinged tops. Consult factory for prices.

OPTIONAL BOXES AND CELL DIVIDERS
For All Upright Freezer And Chest Freezer Racks.

Constructed of recycled paper products, aluminum or stainless steel. Custom sizes available upon request.

OPTIONAL BOXES

CARDBOARD
PART DIMENSIONS

DESCRIPTION NUMBER (OUTSIDE)

Large - 2” B2CL 5³⁄₄” x 5³⁄₄” x 1⁷⁄₈”
Large - 3” B3CL 5³⁄₄” x 5³⁄₄” x 2⁷⁄₈”
Special - 2” B2CS 5³⁄₈” x 5³⁄₈” x 1⁷⁄₈”
Special - 3” B3CS 5³⁄₈” x 5³⁄₈” x 2⁷⁄₈”
Mini - 2” B2CM 3” x 3” 1⁷⁄₈”
Mini - 3” B3CM 3” x 3” x 2⁷⁄₈”

STAINLESS STEEL
PART DIMENSIONS

DESCRIPTION NUMBER (OUTSIDE)

Large - 2” B2SL 5⁵⁄₈” x 5⁵⁄₈” x 1⁷⁄₈”
Large - 3” B3SL 5⁵⁄₈” x 5⁵⁄₈” x 2⁷⁄₈”
Special - 2” B2SS 5¹⁄₄” x 5¹⁄₄” x 1⁷⁄₈”
Special - 3” B3SS 5¹⁄₄” x 5¹⁄₄” x 2⁷⁄₈”
Mini - 2” B2SM 3” x 3” x 1⁷⁄₈”
Mini - 3” B3SM 3” x 3” x 2⁷⁄₈”

ALUMINUM
PART DIMENSIONS

DESCRIPTION NUMBER (OUTSIDE)

Large - 2” B2AL 5⁵⁄₈” x 5⁵⁄₈” x 1⁷⁄₈”
Large - 3” B3AL 5⁵⁄₈” x 5⁵⁄₈” x 2⁷⁄₈”
Special - 2” B2AS 5¹⁄₄” x 5¹⁄₄” x 1⁷⁄₈”
Special - 3” B3AS 5¹⁄₄” x 5¹⁄₄” x 2⁷⁄₈”
Mini - 2” B2AM 3” x 3” x 1⁷⁄₈”
Mini - 3” B3AM 3” x 3” x 2⁷⁄₈”

OPTIONAL CELL
DIVIDERS

100 CELL LARGE
PART CELL OPENING DIMENSIONS

NUMBER MM IN (OUTSIDE)

D100L 12.70     0.50 5¹⁄₂” x 5¹⁄₂”

100 CELL SPECIAL
PART CELL OPENING DIMENSIONS

NUMBER MM IN (OUTSIDE)

D100S 12.70     0.50 5¹⁄₈” x 5¹⁄₈”

25 CELL MINI
PART CELL OPENING DIMENSIONS

NUMBER MM IN (OUTSIDE)

D25M 12.70     0.50 2⁷⁄₈” x 2⁷⁄₈”

Ted Lang



Viewing and Printing Tips for Acrobat PDF Documents 
Note: the interface and specific techniques may vary depending on the version of Acrobat 
Reader that you are using. Adobe Acrobat Reader is a free program. You may download the 
latest version from Adobe.com. To see complete instructions for Acrobat, use the HELP 
button at the top of Acrobat.

PRINTING BETTER VIEWING 
The clarity of a PDF document on your screen may vary 
depending on the size you choose to view the document 
at. 

You can read dimensions better and generally view a 
document better by zooming in. To zoom in, click the 
Zoom In button on the top toolbar (the + sign). Or, 
choose Zoom In from the View menu. You can decrease 
the size of the document with the Zoom Out tool (the - 
sign) 

To zoom in on a specific area, click the Zoom button on 
the toolbar, then click in the area on the document which 
you want to enlarge. Zooming out works the same way. 

You can also view a document at a specific zoom level. 
Select Zoom To from the View menu. The zoom dialog 
box appears. Type the zoom percentage you desire in the 
text box and click OK. The document will be displayed 
at your specified magnification. 

Regardless of the magnification and clarity of the 
document you are viewing, printing the document 
will generally result in a very clear image of text and 
product dimensions. These Acrobat documents are 
optimized to print clearly on your local computer 
printer. 

To print the document to your local computer 
printer, either choose Print from the File menu, click 
the Print button on the File toolbar, or press Ctrl P 
(Command P on the Mac). The Print dialog box 
appears.  

You may select the number of copies you want to 
print in the Print dialog box. 

If you don't want to print the entire document, enter 
the page range (the starting and ending page 
numbers of the pages to print) in the appropriate text 
boxes of the Print dialog box. 

Click OK (Windows) or Print (Mac) 

For additional printing instructions, use the Help 
button on the top toolbar of Acrobat Reader. 

Note: if you need to print this catalog in part or in its 
entirety through a commercial printer, contact 
Custom Biogenic Systems for an Adobe Acrobat 
PDF version suitable for high-end commercial 
printing. 

Ted Lang
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